
Read Me

Pro Tools M-Powered 8.0.1 on Mac
for Pro Tools M-Powered Systems on Mac OS X 10.5 “Leopard” Only

This Read Me documents important compatibility information, known issues, error codes, and corrections to the guides for 
Pro Tools M-Powered 8.0.1 on Digidesign-qualified computers running Mac OS X 10.5.5, 10.5.6, or 10.5.7. 

Compatibility
Digidesign can only assure compatibility and provide support for Digidesign-qualified hardware and software configurations. 

Pro Tools Cannot Record To Drives Formatted as Case-Sensitive (Item #66749)

Pro Tools cannot record to Mac OS X drives which have been formatted as “Case-Sensitive.” Format the Mac OS X record vol-
umes as “Mac OS X Extended (Journaled)” in order to record properly.

PPC-Based Macs and Drive Compatibility (Item #108071)

On PPC-based Macs, Pro Tools is unable to record to drives partitioned with the GUID partition mapping scheme. You may 
experience –9131 errors if you attempt to do so. It is recommended that all audio drives be partitioned using Apple Partition 
Map through Disk Utility instead of the default GUID.

Automatic Update Notification (Item #108837)

Software Updater will not find an active internet connection when behind a proxy server that requires authentication to gain 
internet access. To workaround this, the client machine with Software Updater needs to be moved out from behind the proxy 
or the proxy needs to allow HTTP access via port 80 without requiring authentication.

Known Issues
The following section documents known issues you may encounter when using Pro Tools 8.0.1 on Mac OS X 10.5, along with 
workarounds if they exist.

Pro Tools

Pro Tools Menus and Interface are Grayed Out on Launch (Item #101891)

Pro Tools can appear unresponsive at launch, with the Menus grayed out and browsers inoperable. This can happen because 
of Spaces. If Pro Tools is launched in any other Space than the first one, the Session Quick Start dialog still opens in the first 
Space. You can temporarily disable Spaces, launch Pro Tools and disable the Session Quick Start dialog in the Preferences to 
avoid this problem.

For the latest compatibility information—including Digidesign-qualified computers, operating systems, and third-party prod-
ucts—visit the Digidesign website (www.digidesign.com/compatibility).

For known issues specific to the Music Production Toolkit 2 option for Pro Tools M-Powered, see the Music Production Tool-
kit 2 Read Me.
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Templates Retain I/O Settings and Some Preferences, Display Settings, and Window Layouts (Item #111605)

Pro Tools Session Templates Retain the I/O settings and some of the preferences, display settings, and window layouts from 
the system on which the template was created. Consequently, created a new session based on a template restores several ses-
sion properties from the original system. These properties are retained by Pro Tools until you change them or another session 
or template is opened that replaces them. This also means that if a new blank session is created after using a template, the 
properties from the template will be used for the new session.

The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. 
You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the 
“Install template in system” option), and then selecting the template you want to replace.

Opening Session Created with Pro Tools 7.4 or Lower (Item #: 106746)

When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.0.1, all waveform overviews are recalculated. This 
is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated. This re-
calculation only needs to happen once.

Possible Performance Issues with New Waveform Overviews (Item #110041, 106801, and 106577)

Calculating waveform overviews in Pro Tools 8.0.1 may cause some one time issues with various operations. Once the over-
views are calculated, system performance will return to normal. Areas where you may notice this are:

Legacy Sessions (Item #110041) When opening Legacy Pro Tools sessions for the first time, if you immediately start play-
back, you may encounter various errors advising you to increase the H/W Buffer size, or to delete tracks, or to remove some 
RTAS plug-ins. This is due to the fact that Pro Tools is re-calculating of the session’s waveform overviews in the background. 
Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is calcu-
lated, you will not experience this issue again.

Playback of Newly Created Regions (Item #106801 and 106577) You may notice a slight drop in normal playback perfor-
mance immediately following a record take or after creating or importing new regions. This is due to the fact that Pro Tools 
is calculating waveform overviews in the background, and is mostly only encountered when recording or creating many re-
gions with long durations. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once 
the waveform is calculated, your session playback performance will return to expected levels.

Some Sessions that use Reason with ReWire Don’t Open in Pro Tools 8.0.1 (Item #111757)

Opening some Sessions that contain Reason ReWire will result in the following Reason error: “Engine not responding. Please 
check your ReWire host.” To workaround this problem, launch Pro Tools and create a new session. Then, insert Reason Re-
Wire on any track. Close the session, but keep Reason open. Then, open the session that uses Reason with ReWire that you 
couldn’t open before.

Spotlight Indexing Can Interfere With Long Record Passes (Item #97151)

There are known incompatibilities with Spotlight indexing drives while recording audio. If you will be recording to a large 
number of tracks for over an hour, set all of your drives to private in the Mac OS X System Preferences to ensure maximum 
performance. Failure to do this may result in Pro Tools reporting an error and ending the record pass when Spotlight indexes 
the drives.

Increased Number of Characters in Memory Locations Comments Field (Item # 83593)

In Pro Tools 7.3 and higher, the number of characters allowed in the Comments field for Memory Locations has been in-
creased. When opening Pro Tools 7.3 and higher sessions in previous versions of Pro Tools, any characters beyond 258 will 
be dropped from the Memory Locations Comment text.

CPU Usage Limit May Be Reached when Error Suppression is Enabled (Item #83343)

When enabling Error Suppression at CPU Usage Limit 85% or higher, it may be possible to overload your computer to a point 
at which it is no longer recoverable. To avoid this state, keep your CPU Usage Limit set to 80% or lower when Error Suppres-
sion is enabled.
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Screen Redraw May Slow Down at Higher CPU Usage Limit Settings when RTAS Error Suppression is On (Item #82915)

In some cases, you may experience a slowdown in screen redraw or background CPU tasks when RTAS Error Suppression is 
engaged and the CPU Usage Limit is set to 85 percent or above. If you encounter this behavior while using RTAS Error Sup-
pression, open the Playback Engine Dialog and lower the CPU Usage Limit by 5 to 10 percent. 

Software Instrument Does Not Emit Sound when Inserted on an Instrument Track or Auxiliary Input (Item #65797) 

Some software instruments will not emit sounds and will not play unless they have a valid hardware input or MIDI output 
assignment. If this occurs, manually assign a hardware input to the Instrument track or Auxiliary Input, and/or manually as-
sign a MIDI output to the Instrument.

Dropped Region Loops when Saving Sessions as Pro Tools 5.1 to 6.9 Format (Items #90102, 90079)

When saving a session as a 5.1 to 6.9 format, a dialog appears informing the user that “Region Loops will be dropped.” As a 
workaround, highlight all audio files and choose Region > Unloop > Flatten before saving the session as a lower version of 
Pro Tools.

Audio Regions on Tick-Based Tracks Do Not Play at the Correct Tempo after Opening a Reason Song with a Different Tempo 
(Item #96710)

Audio regions on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different 
from the one in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input 
and the regions will play back correctly.

Import Audio Incorrectly Splits a Stereo Interleaved WAV file that contains IXML Metadata into Two Separate Mono Tracks 
(Item #98841)

Import Audio incorrectly splits a stereo interleaved WAV file that contains IXML metadata into two separate mono tracks. 
Please use the workspace instead to drag the file into the Edit window or directly onto a stereo track. 

Opening a Session with a QuickTime Movie as a Non-Administrator User Can Prevent the Movie from Playing Back 
(Item #47053)

If you open a session as a non-administrator user and you do not have permissions for the QuickTime movie file, Pro Tools 
will tell you that the movie file cannot be found and prompt you to relink. In the relink window the movie can be found and 
Pro Tools will appear to relink to it but it will still not play back. For correct playback, make sure you have permission to use 
the QuickTime movie file.

MP3 Codec Exports Non-Copyright Files Only (Item #68985)

The MP3 codec in Pro Tools 7.3 and higher does not have the ability to encode an attribute for the file to be copyrighted. This 
is a limitation of the codec from Fraunhofer. 

48 kHz Bounce to MP3 in Pro Tools 7.x and Higher Results in a 44.1 kHz MP3 File (Item #72617)

Bouncing to MP3 while using the “Highest Quality Encoding, Slower Encoding Time” setting with any bit rate other than 
320kbps will result in a 44.1kHz file. This is a known limitation of the encoder.

Some QuickTime Audio Formats Cannot Be Imported (Items #58792, 73064)

The audio from QuickTime movies with Apple Lossless or AMR audio compression cannot be imported into Pro Tools. Use 
QuickTime Pro or another application to convert the audio to another format prior to import.

Apple Lossless Codec Is Not Supported for Bounce to QuickTime Movie (Item #75224)

Pro Tools 7.3 and higher does not support the Apple Lossless audio codec. Choosing it from the Bounce to QuickTime Movie 
Audio Compression dialog will result in a movie without usable audio.
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Automation Window Update when Writing Automation (Item #111105)

When writing automation on Volume, Pan, and so on, the corresponding buttons in the Automation window provide no in-
dication that automation on the related control is being written. You will need to observe the automation buttons on tracks 
in Mix or Edit windows to see an indication that automation is being written.

File and Disk Management

Missing Files when Opening a Session that Was Saved Using Save Copy In with Preserve Folder Hierarchy (Item #74454)

The Preserve Folder Hierarchy feature is designed so that sessions with media split between multiple volumes can be easily 
moved between systems while retaining folder hierarchy. In order for media files to be automatically found, manually copy 
or create a folder at the root level of each volume with the session name that contains the Audio Files or Video Files folder. 
Or, manually relink to the missing files at their current location. 

Session Copy Saved with Preserve Folder Hierarchy in which Multiple Files Have the Same Name Does Not Relink Properly 
(Item #79868)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when 
using Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has 
already been opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to man-
ually relink the remaining files.

MIDI

When Recording MIDI, Wait for Note Does Not Respond to MIDI Input from Rewire (Items #90724, #97444)

When performing a MIDI record, Wait for Note will not respond to any MIDI received from Rewire. If you are recording MIDI 
generated from a Rewire application, you will have to start the transport manually or use a countoff instead of Wait for Note.

When Using Import Session Data on a MIDI Track with Real-Time Properties Enabled and Set to Using Diatonic 
Transposition, Transposition is Based on the First Key Signature in the Session Only (Item #81666)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the 
“Transpose in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can 
be corrected by toggling the Real-Time Properties off and on, at which point the diatonic transposition will be correct for each 
key.

Unavailable MIDI Input Paths for MIDI and Instrument Tracks are not Indicated (Item #111221)

The device or path name for MIDI Input on MIDI and Instrument tracks is not italicized and grayed out when opening a ses-
sion on a system where the device or path are not actually present.

Elastic Audio

Changes to Elastic Audio Algorithms in Pro Tools 8.x (Item #109141)

Several changes have been made to Elastic Audio signal processing in Pro Tools 8.0 and higher. In some cases, you may notice 
improvements with timing accuracy of events when time warping audio using the Polyphonic algorithm. In other cases, you 
may notice sustained low frequency content sounds smoother when time stretching using the Rhythmic algorithm. The X-
Form algorithm was upgraded as well, and exhibits better pitch coherency on certain polyphonic audio sources. While the 
aim was to improve sonic performance, it is important to note that sessions using Elastic Audio processing can sound differ-
ent when played in Pro Tools 8.x than the same sessions did in Pro Tools 7.4. To reproduce Elastic Audio processing identical 
to Pro Tools 7.4, you can replace Elastic Audio version 8.0.1 with version 7.4 and commit your audio tracks if necessary. Note 
that version 7.4 does not support Elastic Pitch. 
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Change Between Pro Tools 7.4 and 8.x in how Transient and Warp Markers Affect Sound Quality (Item #105159)

Both the Polyphonic and Rhythmic Elastic Audio algorithms rely on transient analysis to achieve optimal fidelity and timing 
accuracy. Reducing event sensitivity, and consequentially removing Analysis or Warp markers, may adversely affect the 
sound quality and timing of elastic regions. Conversely, an overabundance of Analysis markers or Warp markers, can also ad-
versely affect sound quality. For best results, make sure that Analysis markers are reasonably correct vis a vis the musical 
events in an audio region. Note that to achieve the highest sound quality, the Polyphonic algorithm in Pro Tools 8.x is more 
reliant upon Analysis markers than in Pro Tools 7.4.

Unusual Audio “Warble” with Polyphonic Elastic Audio (Item #103038 and #108845)

In some cases, some audio that is being processed with the Polyphonic Elastic Audio algorithm may sound “warbly.” If this 
occurs, try adjusting the Window Length control in the Polyphonic Elastic Audio Plug-in window until the warble goes away. 
If you are opening a session that previously used the default Window Length setting in Pro Tools 7.4.x, which was 30 ms, a 
recommended starting point would be 40 ms. 40 ms is also the new default parameter value for the Polyphonic Elastic Audio 
algorithm in Pro Tools 8.x.

Tempo Maps Made from Bar|Beat Marker Generation in Beat Detective Cause Region Groups in Rendered Mode to Fall 
Offline (Item #97993)

A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause region groups in Rendered mode to fall of-
fline. The workaround is to make an edit to the offline region and then toggle the Elastic Audio from rendered to real-time 
and then back to rendered.

Real-Time Elastic Audio Tracks Do Not Show Accurate Waveforms (Item #98343)

When using Elastic Audio Real-Time Processing, Pro Tools displays the varispeed waveform in Waveform view no matter 
which algorithm you are using. This is done because all of the Elastic Audio processing is done in real-time and the waveform 
is a prediction of what it will sound like. Switching to Rendered mode will give you an actual representation of the audio as 
rendered by the algorithm you are using.

Maintaining Phase Coherency with Elastic Audio Pitch Processing (Item #106002)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Mono-
phonic or Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio 
Pitch processing from the track before switching to the Monophonic or Varispeed algorithm.

Certain Audio Files Cannot Be Calculated or Cleared of Elastic Analysis in Workspace Browser (Item #89026)

There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either .WAV or .AIF), 
but the Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Cal-
culate Elastic Analysis and Clear Elastic Analysis will be greyed out. In these cases, the file may actually be in a non-supported 
format. To check the file’s format, look at the Format column in the Workspace browser. If a file format other than WAV or 
AIFF is shown (such as QuickTime), then the file cannot be calculated or cleared of elastic analysis. Note that these non-sup-
ported files can still be previewed in tempo, as well as elasticized once imported into a session.

Drift in an Audio File May Occur when Using Elastic Audio and the Monophonic or X-Form Algorithms (Item #96151)

Drift in an audio region may occur when using elastic audio depending on how much the regions is expanded or compressed 
when using the Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient in-
formation in it that you would like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.

Default Input Gain Preference Is Only for Elastic Audio Imported at Session Tempo (Item #96725)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported 
at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or 
“Drag and Drop from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.
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Displayed Timebase is Incorrect after Importing Elastic Audio Tracks (Item #111299)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will 
need to manually select the correct timebase for the affected tracks.

Elastic Audio Regions on Playlist Lanes Are Not Rendered (Item #111882)

In Playlists View, any Elastic Audio regions on Playlist lanes are not rendered (waveform is “off-line”) when changing the 
track’s Elastic Audio processing from Real-Time to Rendered.

Region Groups Containing Elastic Audio Are Not Recognized as Elastic if the Region Group Itself Has Not Had Any Elastic 
Functions Applied (Item #92770, #97107)

If a region group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level 
of the region group itself, then the region group will not register as Elastic Audio. When used to create a new track, the track 
will not automatically be Elastic Audio–enabled, and the elastic audio inside the region group will be rendered using the de-
fault Elastic Audio plug-in for the session. As a workaround, add a warp marker to the region group to force it to register as 
an elastic region. Or, create an Elastic Audio–enabled track first, then add the region group to it.

Cannot Import Elastic Audio Tracks with the Consolidate From Source Media Option (Item #96404)

Use Copy from Source Media to import Elastic Audio tracks. 

Timing Inaccuracy in Audio Files Converted from CAF and MP3 with Preview In Context Enabled (Item: 111064)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio 
and inner-region asynchronous transients issues). This is inherent with compressed file formats.

Plug-ins

AudioSuite and Region Groups (Item #64410)

AudioSuite plug-ins handle Region Groups in the Region List slightly differently than audio files. With audio files, an Audio-
Suite process can be applied to all copies of a unique audio file which appear in your session by selecting your target as Region 
List in the AudioSuite plug-in window and selecting Use in Playlist. However, if your target is set to Region List in the Audio-
Suite plug-in window while you have a Region Group selected, Pro Tools does not recognize the Region Group as processable 
audio and will present a No Audio was Selected error. This is because a Region Group is not treated as audio until it is actually 
used in a track.

To apply an AudioSuite process to all copies of a Region Group in a session at once, do the following:

1  Select the Region Group to be processed.

2  From the Region List menu, select Ungroup All. All elements of the group will remain selected.

3  Perform AudioSuite processing.

4  From the Region List menu, select Regroup.

When prompted, select Modify to apply the AudioSuite Process to all copies of the Region Group in the session, or Copy to 
apply it only to the selected Region Group.

Plug-in Find and Relink with File Types not Supported by Pro Tools (Item #111704)

Find and Relink will not be triggered by plug-ins in situations where plug-ins supporting Find and Relink are missing links to 
file types that are not natively supported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the 
file types used in plug-ins must also be supported by Pro Tools.

For known issues about specific plug-ins, see the Digidesign Plug-ins Read Me.
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Video

Unsupported QuickTime Video Formats (Items #72933, 72956, 72958, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format 
movies. Attempting to import these will generate errors or will fail to import.

Standard Definition QuickTime Movies Are Rendered as 16:9 Anamorphic Play Back in Pro Tools at 4:3 (Item #109076)

Standard Definition QuickTime movies rendered with 16:9 an anamorphic Scaled Size of 853x480 play back in Pro Tools at 
4:3 or 720x486 resolution. The Scaled Size attribute of QuickTime movies is ignored by Pro Tools. To workaround this prob-
lem, render the movie letterbox natively within the 720x486 pixel dimension.

Dragging from Mac Finder in Shuffle Mode Does Not Work Correctly with Video (Item #78451)

Dragging a Video file from the desktop to the Edit window while in Shuffle mode will always place the video at session start, 
overwriting existing video regions in that location.

Pro Tools UI May Slow Down with Densely Edited QuickTime Movie Track (Item #77720)

Pro Tools may begin to respond more slowly and update less often as a session with one or more QuickTime video tracks be-
comes more and more densely edited. If, while working with heavily edited QuickTime clips, Pro Tools responsiveness begins 
to decline, use the Bounce to QuickTime Video command, then import the bounced movie.

MPEG-1 and MPEG-2 Video Freezes at Edit Points (Item #79182)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the 
Video window, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-
1 or MPEG-2 movie with a 3rd party application may also fix the problem.

Audio from “Muxed” MPEG-1 and MPEG-2 Movies Cannot Be Imported and Will Be Heard in a Bounced Movie 
(Item #76063)

Unlike other QuickTime formats, MPEG-1 and MPEG-2 movies store audio and video in a single multiplexed track, called a 
“muxed.” track. Pro Tools cannot separate the audio from video for these types of movies. As a result, you will not be able to 
import the audio from an MPEG-1 or MPEG-2 movie. Also, if you Bounce to QuickTime using an MPEG-1 or MPEG-2 movie 
as a source movie, the original audio from the movie will be present in the bounced movie (even though it will not be heard 
while working with the movie in Pro Tools). To import audio from an MPEG-1 or MPEG-2 file, use a third party application 
to “demux” the MPEG stream.

When Using Bounce to QuickTime, Do Not Bounce to an Existing Movie Name (Item #76768)

If you use the Bounce to QuickTime command and use the same name as an existing movie, the bounce may fail. It is best 
to use a unique name for each bounce, or delete the previous movie from the drive prior to bouncing with the same name 
(rather than choosing to replace the existing file).

General Localization 

Session Notes or Session Info Text Files Saved in Japanese May Not Open in TextEdit (Item #111038)

Session Notes (you can generate these if you are missing plug-ins or have problems when opening a session) or Session Info 
(File > Export > Session Info as Text) text files may not open in TextEdit, depending on the TextEdit preference settings. This 
is because the files use different text encoding. As a workaround, you can use the Console application to open files or you can 
use the Open menu item in TextEdit, then choose the correct encoding, as follows:

• Session Notes - UTF-8

• Session Info - Japanese (MacOS)
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Certain Chinese Characters Need to Be Initiated in the Mac OS Before They Can Be Used for Naming in Pro Tools 
(Item #95008)

If you cannot use certain characters for naming in Pro Tools, use Text Edit in Mac OS X to initiate the characters. In Text Edit, 
type the same characters you were trying to use, then use the mouse to select the correct ones from the pop up menu. You 
should now be able to use them in Pro Tools.

Error Messages

Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you 
will need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 
error, quit and relaunch Pro Tools, open the Playback Engine dialog, and change the Number of Voices to a setting that uses 
fewer voices per DSP. 

DAE Error –9073 Without Reaching the 2 GB File Limit

If you encounter a –9073 error, and you have not reached the 2 GB file size limit, please refer to the Answerbase for possible 
causes and solutions (http://answerbase.digidesign.com).

DAE Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid 
–9128 errors during playback with RTAS plug-ins or dense automation.

DAE Error –9131 (Items #92747, #20843)

GUID partitioned drives will not allow you to record beyond the third partition when running on OS X. A workaround is to 
partition audio drives using Apple Partition Map instead of GUID.

– or –

Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools.

DAE Error –9132 (Item #32397)

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the appropriate 
tracks to the appropriate number and format of audio tracks, and record to disk. You can then use the resulting audio files as 
you would have used bounced files.

DAE Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid 
–9155 errors during playback with dense automation.

DAE Error –9735

When Pro Tools reaches the end of its time limit in the session Timeline, or if Pro Tools has been in continuous play for lon-
ger than the maximum time limit, you will encounter a DAE error –9735. The maximum time limit for Pro Tools depends on 
the session sample rate. For more information, see the Pro Tools Reference Guide.
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Corrections to Pro Tools Guides

What’s New Guides
Part Number 9320-59102-00 REV A 11/08

The following identifies corrections to and omissions from both the What’s New in Pro Tools LE and M-Powered 8.0 Guide.

Time Locking Regions

On page 38 of the What’s New in Pro Tools LE and M-Powered 8.0 Guide, the keyboard shortcut tip for Time Locking regions in-
correctly states, “Press Shift+T to Time lock or unlock the selected region.” 

Corrections:

The keyboard shortcut tip should read, “Press Alt+Start+L (Windows) or Option+Control+L (Mac) to Time lock or unlock the 
selected region.”

Pro Tools Reference Guide
Part Number 9106-59126-00 REV A 11/08

The following identifies corrections to and omissions from the Pro Tools Reference Guide.

Toolbar Focus

On page 25 of the Pro Tools Reference Guide, documentation of Toolbar focus is incorrectly omitted.

Corrections:

The following section for “Toolbar Focus” should be added right after the section on “Keyboard Focus:”

Toolbar Focus

In the Edit window, the MIDI Editor pane can be displayed in addition to the Tracks pane (View > Other Displays > MIDI Editor). 
When the MIDI Editor pane is displayed, there are two separate Toolbars and Timelines in the Edit window: one for the Tracks 
pane and one for the MIDI Editor pane. Only one Toolbar and Timeline can be focused for Menu and Toolbar commands (in-
cluding the corresponding keyboard shortcuts) at a time. The focused Toolbar displays a orange outline. 

If Keyboard Focus for the Edit window is enabled, it follows the selected Toolbar focus.

To enable Toolbar focus for the Tracks pane, do one of the following:

Click the Toolbar at the top of the Edit window.

– or –

Press Control+Alt+4 (Windows) or Command+Option+4 (Mac).

To enable Toolbar focus for the MIDI Editor pane, do one of the following:

Click the Toolbar right above the MIDI Editor pane.

– or –

Press Control+Alt+5 (Windows) or Command+Option+5 (Mac).

Pro Tools LE System Capabilities

On page 34 of the Pro Tools Reference Guide, the final paragraph incorrectly states, “Pro Tools LE systems provide up to 128 
Auxiliary Input tracks, a total of 32 internal mix busses, and up to 5 inserts and 10 sends per track (depending on your com-
puter’s processing capacity). In addition, Pro Tools LE systems support up to 32 Instrument tracks and 256 MIDI tracks. 
Pro Tools LE also supports a single QuickTime video track.”
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Corrections:

The paragraph should read, “Pro Tools LE systems provide up to 128 Auxiliary Input tracks, a total of 32 internal mix busses, 
and up to 10 inserts and 10 sends per track (depending on your computer’s processing capacity). In addition, Pro Tools LE sys-
tems support up to 32 Instrument tracks and 256 MIDI tracks. Pro Tools LE also supports a single QuickTime video track.”

Zoom Toggle Preferences

On page 90 and also on page 455 of the Pro Tools Reference Guide, the paragraph on the “Separate Grid Settings When Zoomed 
In” preference incorrectly states:

Separate Grid Settings When Zoomed In When selected, this option retains the same (current) grid setting when zoom tog-
gling in or out. When this option is deselected, the grid setting stored with Zoom toggle is recalled when zoom toggling in. 

Corrections:

The paragraph should read:

Separate Grid Settings When Zoomed In When selected, the Grid setting stored with Zoom toggle is recalled when zoom tog-
gling in. When this option is deselected, the same (current) grid setting is used whether zoom toggling in or out. 

Notes View for MIDI and Instrument Tracks

On page 435 of the Pro Tools Reference Guide, the ability to use a mouse with a scroll wheel to scroll up or down in Notes View 
is omitted.

Corrections:

The following step should be added to the procedure for scrolling the Notes display up or down for a MIDI or Instrument 
track: “If you have a mouse with a scroll-wheel, move the cursor over the track and Control-Alt-Start-scroll (Windows) or 
Command-Option-Control-scroll (Mac) up or down to scroll the notes display up or down.”

Time Locking Regions

On page 731 of the Pro Tools Reference Guide, the keyboard shortcut tip for Time Locking regions is incorrectly states, “Press 
Shift+T to Time lock or unlock the selected region.” 

Corrections:

The keyboard shortcut tip should read, “Press Alt+Start+L (Windows) or Option+Control+L (Mac) to Time lock or unlock the 
selected region.”

Dragging and Dropping Plug-in Settings Files

On page 891 of the Pro Tools Reference Guide, the section on “Dragging and Dropping Plug-in Settings Files” erroneously states 
that you can drag and drop plug-in settings files from Windows Explorer or the Mac Finder to inserts and plug-in windows. 

Corrections:

The section on “Dragging and Dropping Plug-in Settings Files” should read:

To insert a plug-in by drag and drop:

Drag and drop a plug-in settings file from a DigiBase browser to an Insert in the Mix (or Edit) window.

To change a plug-in preset by drag and drop:

Drag and drop a plug-in settings file from a DigiBase browser to the plug-in window. The plug-in settings file must be for 
the same plug-in name. For example, you cannot replace a 1-Band EQ 3 with a plug-in setting for 4-Band EQ 3.
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Menus Guide
Part Number 9329-52920-00 REV A 11/08

Track Menu

On page 33 of the Pro Tools Menus Guide, the following menu items are not available (however, the keyboard shortcuts for 
these items remain functional):

• Solo Tracks with a Selection

• Mute Tracks with a Selection

• Record Arm Tracks with a Selection

• Input Monitor Tracks with a Selection (Pro Tools HD Only)

Corrections:

The entire “Solo, Mute, Record Arm, and Input Monitor Tracks with a Selection Commands” section should be deleted.

Trillium Lane Labs Plug-ins Guide
Part Number 9329-59303-00 REV A 11/08

Introduction

The TL Labs AutoPan™ is incorrectly listed as a paid plug-in, but it is included free and installed with Pro Tools 8.0.1. 

Corrections:

TL Labs AutoPan should be listed under Free Trillium Lane Labs Plug-ins and should be deleted from under Paid Trillium Lane 
Labs Plug-ins.
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